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EMAIL SETUP: Step 1

rﬂ Inbox - Microsoft Cutlook

! File Edit View Go Actions  Help

Send/Receive

Instant Search

Mail

o . Fa::rlr'rte Folders ] Address Book..,  Ctrl+Shift+B
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select Account Settings

Mailbox Cleanup...

from the Tools menu. ;
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E-mail Scan Properties...
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EMAIL SETUP: Step 2

Create a new emall Aecount Settng;
account. From within the
E-mail tab of the
Account Settings
window, Select “New...”




EMAIL SETUP: Step 3

Add Mew E-mail Account

In the Add New
E-Mail Account
window, select
“Microsoft
Exchange,
POP3, IMAP, or
HTTP” and then
click Next.

net service provider (ISF) or your




Add Mew E-mail Account

In the Add New |-
E-Mail Account
window, select
“Manually
configure server
settings or
additional server
types”, then
click Next.

EMAIL SETUP: Step 4




EMAIL SETUP: Step 5

Add Hew E-mail Account

Choose E-mail Service

In the Add New |
= i
E . I\/I ai I A C C O u n t Connect to your POP, IMAP, or HTTP server to send and receive e-mail messages.

(") Microsoft Exchange

= Connect to Microsoft Exchange for access to your e-mail, calendar, contacts, faxes and voice mail.
window, select
)

() other

(11 I nternet E_mai I L1 : Connect to a server type shown below,
then click Next.




EMAIL SETUP: Step 6
In the Add New

E-Mail Account
window enter
the following:

Add Mew E-mail Account

Internet E-mail Settings
Each of these settings are required to get your e-mail account warking.

User Information Test Account Settings
Your Name: . .
: : Your Mame: Joe Elogas After filing out the information on this screen, we
As you wli sh emails = recommend you test your account by dicking the

E-mail Address: joe.bloggs @us.army.mil button below. {Requires network connection)

to appear “From”
Server Information

. Test Account Settings ...
E-mail Address: Account Type: IMAR
your. AKO@ us.army.mi 1 Incoming mail server: imap.ug. army.mi
Outgoing mail server (SMTF): | mailrouter,us.army.mil

Account Type:
IMAP Logon Information

User Mame: joe.bloggs
Incoming mail server:
imap.us.army.mil

Password: seseseseseseseseseseseseesen]
Remember password
out goi ng ma 11 server: [ ]Reguire logon using Secure Password Authentication (SPA)
mailrouter.us.army.mil

User Name:
your.ARKO

Password:

yourAKOpassword Select “Remember password,”
then select More Settings...



EMAIL SETUP: Step 7

In the General tab of the
Internet E-mail Settings  [EEEEEDE
window, give your mail TR
account a name if you wish.
(This defaults to the email
address. The name is your
choice and has no
operational effect.)
Select “Purge items when
switching folders while
online” then change to the
Outgoing Server tab.




EMAIL SETUP: Step 8

Internet E-mail Settings

In the Outgoing Server tab of
the Internet E-mail Settings
window, select “My outgoing
server (SMTP) requires
authentication” and select
“Use same settings as my
incoming mail server” then
change to the Advanced tab.




In the Advanced tab of
the Internet E-mall
Settings window, enter

the following information:

Incoming server (IMAP):
993

Use the following type of
encrypted connection:
SSL

Outgoing server (SMTP):
465

Use the following type of
encrypted connection:
SSL

EMAIL SETUP: Step 9

Internet E-mail Settings

General || Folders || Outgoing Server | Connection | Advanced
Server Port Numbers
Incoming server (IMAP); | 993
IUse the following type of encrypted connection: |55
Qutgoing server (SMTF): | 485]
se the following type of engrypted connection: |55
Server Timeouts
Short 7 Long 1 minute

Folders

Root folder path:

Note: Outlook has a small bug here. When you select the outgoing server to use
SSL, Outlook will revert your entered setting of 465 to the default of port 25.
Either set SSL first or change back to 465 before leaving this window.



EMAIL SETUP: Step 10

et your e-mail account working,

Test Account Settings

After filing out the information on this screen, we

recommend you test your account by dicking the

In the Add New E-mail R
Account window, select B -
“Test Account Settings...” =&

entication (SPA) More Settings ...




EMAIL SETUP: Step 11

In the Test Account
Settings window, If all
settings are correct and geyrETT
yOU h ave gOOd netW Ork Congratulations! All tests completed successfuly. Click Close to continue.
connectivity, a —
successful completion |IR e ——
should result after a few |[Nu———
seconds. Click Close.
(If you experience
fallures, double-check
previous steps.)




EMAIL SETUP: Step 12

et your e-mail account working.

Test Account Settings

I t h A d d N E " | After filling out the information on this screen, we
n e eW . I I I al recommend you test your account by dicking the

| @us. army.mil button below, (Requires network connection)

Account window,
select Next.

army.mil

Mare Settings ...




EMAIL SETUP: Step 13

Change E-mail Account

Congratulations!

You have successfully entered all the information required to setup your
account,

To dose the wizard, dick Finish,

In the Change
E-mail Account
window,
select Finish.




EMAIL SETUP: Step 14

i
8 sent ltems - Microsoft Outlook
Edit View Go Tools
Mew I
Mcroson
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Close All Items

Cla wicowre
i a}n.Ofﬂce Outlook: 2007

Save :\J
@ Internet
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. E-mail
L =) Microsoft Office Outiook
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Folder

Data File Management...

.
Import and Export... 8 inbox in AKO - Microsoft Outlook
Archive... : File Edit View Go Tools At

. . . . PoadNew ~ | Y X | Reply
- Exit, then re-launch, Mail

.::ialcﬂeé E—.:-change Maode O u t I O O k . YO u r A K O E::;r:d:l:ers
Waork Offline ) . i : i} 2| All Mail Ttems
email 1s now visible in O e e

the Mail Folders s

Page Setup

L @ Junk E-mail

hierarchy. Expand it, 3 et s

& L Search Folders

and within a few
seconds your AKO

(= sent
[ Spam

folders will populate. S

& L Search Folders

PEDD DD




From within Outlook,
select Account Settings
from the Tools menu.

EMAIL SETUP: Step 15

rﬂ Inbox - Microsoft Cutlook

! File Edit View Go

Mail
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Mail Folders
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Instant Search
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Forms

Macro
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Scan for Threats... I
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In the Account
Settings window,
select your
AKO account
(named as you
selected in Step
7), then click
“Change...”

Account Settings

EMAIL SETUP: Step 16




EMAIL SETUP: Step 17

Add New E-mail Account

Internet E-mail Settings
Each of these settings are required to get your e-mail account working.

In the Add New

User Information Test Account Settings
E - m al I A C C O u n t Your Mame: Joe Elogas After filing out the information an this screen, we
— recommend you test yvour account by dicking the
. E-mail Address: joe.bloggs @us. army.mil button below. (Requires netwark connection)
window, select B

Test Account Settings ...
Account Type: IMAP

(1 H )
M O re S ettl n g s "Em Incoming mail server: imap. us. army.mil
Qutgoing mail server (SMTP): | mairouter,us.army, mil
once more.

Logon Information

User Mame: joe.bloggs

Easﬂhlﬂrd: ::::::::::::::ﬂ

Remember password

[ ]Require logon using Secure Password Authentication (SPA)




EMAIL SETUP: Step 18

In the Internet E-mail |
Settings window, select RS S
“Choose an existing folder |t
or create a new folder to
save your sent items for
this account in” then
select the Sent folder
beneath the AKO account
hierarchy. (The top-level
folder will reflect the name
you selected in Step 7.)
Select OK.




EMAIL SETUP: Step 19

et your e-mail account working.

Test Account Settings

I t h A d d N E " | After filling out the information on this screen, we
n e eW . I I I al recommend you test your account by dicking the

| @us. army.mil button below, (Requires network connection)

Account window,
select Next.

army.mil

Mare Settings ...




EMAIL SETUP: Step 20

Change E-mail Account

Congratulations!

You have successfully entered all the information required to setup your
account,

To dose the wizard, dick Finish,

In the Change
E-mail Account
window,
select Finish.




EMAIL SETUP: Complete

@ nbox in AKO - Microsoft Outlook

Email setup is now
® complete. Your AKO
cavorte Foers email folders are

Mail Folders

T = accessible in your Mail

= €4t Mailbox - Wetzel, Adam

Sl ¥ Folders list along with @" "

1 any other accounts

I File Edit View Go Tools Adi

U= Outbox
=4 sent Items

# L3 Search Folders - yo u m ay h ave .

= & AKO

[ Spam

e When composing messages you now
have the option of changing the
account from which you are sending.
You may also configure signatures
for each account independently.




DIRECTORY SETUP: Step 1

rﬂ Inbox - Microsoft Cutlook
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Mail

o . Fa::rlr'rte Folders ] Address Book..,  Ctrl+Shift+B
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select Account Settings

Mailbox Cleanup...

from the Tools menu. ;
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Forms
Macro
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E-mail Scan Properties...

Scan for Threats... I
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DIRECTORY SETUP: Step 2

Account Settings

In the Account Settings
window, select the
Address Books tab,
then click “New...”

Directories and Address Books

fou can choose a directory or address book below to change




DIRECTORY SETUP: Step 3

Add Mew E-mail Account

Directory or Address Book Type
You can choose the type of directory or address book you'd like to add.

In the Add New
E-Mail Account " oo o s o sty .k s st
window, select O e s sk vty s
Internet
Directory
Service (LDAP)

then click Next.




DIRECTORY SETUP: Step 4

In the Add New
E-Mal I ACCO u nt Add New E-mail Account
W I n d O W ] e n t e r t h e Dire‘:':n:tn::;:rug :::;;{:Lrn:;:?jig;‘:; to access information in a directory service,
following with |
Server Information
N O S PA C E S Type the name of the directory server your Internet service provider or system administrator
has given you.

server Name: directory. us. army.mil

eX C e p t i n Logon Information
(11 U .S ] Gove rn me nt!! : [+] This server requires me to log on

User Mame: cn=joe. bloggs,ou=people, ou=~

Password:
Server Name:
direct ory.us.army mil [ ]Reguire Secure Password Authentication (SPA)
More Settings ...
This server requires me to
log on (select checkbox)

User Name:
cn=your.akousername,
ou=people,ou=Army,ou=DoD,
o=U.S. Government,c=US

Password:

yourakopassword Next, select “More Settings...”



DIRECTORY SETUP: Step 5

When you select “More Settings...” you
will see the Add E-Mail Account dialog
reminding you to close and re-launch
Outlook so the settings will take effect.

This is normal. Select OK.

Add E-mail Account

LI
\ 1 ;) The E-mail Account you have just added will not start until you choose Exit from the File menu, and then restart Microsoft Office Qutlook,
=




DIRECTORY SETUP: Step 6

In the Connection tab of the
Microsoft LDAP Directory
window, select a name for the
directory account.
“AKO Global Directory” was S
used in this example, but this
IS your choice and has no
operational effect. Then, enter:

Port:
636

Microsoft LDAP Directory

Use Secure Sockets Layer
(select checkbox)

Next, select the
Search tab.



DIRECTORY SETUP: Step 7

In the Search tab of the
Microsoft LDAP Directory Microsoft LDAP Directory
window, enter the following
Information. Again, use
NO SPACES except in
“U.S. Government”:

Server Settings section:
Leave defaults of 60 and 100

Search Base section,
select Custom and enter:
ou=people,ou=Army,ou=DoD,

o=U.S. Government,c=US

Then, select OK.



In the Add New
E-Mail Account
window,
select Next.

DIRECTORY SETUP: Step 8

Add Mew E-mail Account

Directory Service (LDAP) Settings
You can enter the required settings to access infarmation in a directary service,

Server Information

Type the name of the directory server your Internet service provider or system administrator
has given you.

directory,us.army.mil

Logon Information

This server requires me to log on

User Mame: cn=joe. bloggs,ou=people, ou=~

Password:

[ ]Reguire Secure Password Authentication (SPA)




DIRECTORY SETUP: Step 9

Change E-mail Account

Congratulations!

You have successfully entered all the information required to setup your
account,

To dose the wizard, dick Finish,

In the Change
E-mail Account
window,
select Finish.




DIRECTORY SETUP: Step 10

Account Settings

Directories and Address Books
¥ou can choose a directory or address book below to change or remove it.

In the Account
Settings Window, |
the new AKO N
directory is now |IEEEad
listed along with
your existing
Exchange
directory.

Select Close.




r

8 sent ltems - Microsoft Outlook

Edit View Go Tools
Mew

Open

Close All Items

Save As...

Save Attachments

Folder

Data File Management...

Import and Export...
Archive...

Page Setup

Print Preview

Frint...

Cached Exchange Mode

Work Offline

Exit, then re-launch,

Outlook once again. T R
Enter the Address Book 5 outoor
using either the toolbar PEeEps

button or the menu. nmwena | e

DIRECTORY SETUP: Step 11

Microsoft
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DIRECTORY SETUP

In the Address Book
window, your new
AKO Directory
should be visible at
the very bottom of
the list. If so,
directory setup iIs
complete. The next
page illustrates a
search of the
directory.

i Address Book: AKO Global Directory

File Edit Tools

Search: Mame on {*) More columns

EECP

Type your search keywords and click 'Go| Ft.l McPhersan
LFCP

BAHRAIM MSA

CENTCOM
JTFHOA
KUWAIT

MMFI
Public Faolders

QATAR Camp As
S )]

SALDI
L

. Complete

Salivah



DIRECTORY SETUP: Usage

In the Address

Book window, enter prmmsrrrn
search criteria and [

click Go or press =

Enter to execute .
the search. Results
appear in the same

window.

If the search returns a
large number of hits,
! The LDAP Directory Server found more entries for this search than your spedified size limit. O n Iy 100 Wi I I b e

Only the first 100 entries will be displayed.

Microsoft LDAP Directory

displayed. Choose
more restrictive
criteria if this occurs.



AKO ON OUTLOOK: Final Notes

Micresoft

m'.\_ Microsof.t'
i g.Ofﬁce Outlook: 2007

* KO ——

COMPLETE! Do remember that when
your AKO password expires, you must
first change it in the AKO website, then

update with the new password in
Outlook’s Account Settings for both the
email and the address directory accounts.




